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Fibre Orientation & Tractography 

Contents: 

FSL Bedpostx 

Estimating Fibre Orientations using model-based deconvolution 

FSL Probtrackx - Tractography 

Generating connectivity distributions 

Connectivity-based segmentation 

Using connectivity to classify voxels 

Connectome Matrix Generation 

Understand the different options for whole-brain connectome generation 

Explore precalculated dense and parcellated connectomes 

 

FSL Bedpostx - Estimating fibre orientations using model-based deconvolution 

In the previous practical we saw what the diffusion MRI data look like, went through the preprocessing 
steps that are needed to correct for the distortions before doing any analysis, and fitted the DTI model 
to the dMRI data. The diffusion tensor model allows a single fibre orientation to be estimated per voxel. 
For achieving better tractography, we need to consider cases where multiple fibres cross within a voxel. 
FSL's tool BedpostX includes a range of models for estimating multiple fibre orientations. 

This section will familiarise you with the Bedpostx toolbox in FSL, which performs a parametric (model-
based) deconvolution of the diffusion signal to fibre orientations. Bayesian inference and Monte-Carlo-
Markov-Chain (MCMC) is used on a voxel-by-voxel basis for estimation. Thus, the output comprises 
samples from the posterior distribution of the model parameters given the data in a voxel, including the 
fibre orientation distribution that will then be subsequently used for probabilistic tractography.   

To start: 

cd /home/hcpcourse/day3-wednesday/Diffusion_practicals 

cd 100307/T1w/Diffusion.bedpostX 

Because it takes a considerable amount of time to run, bedpostX has already been run for you. If you 
were running it yourself on the HCP data, you would use the following command:  

bedpostx ../Diffusion -n 3 -b 3000 -model 3 -g --rician 

This models up to n=3 fibres per voxel, uses a "zeppelin" single-fibre response kernel for deconvolution 
(model=3 - see lecture) and a Rician noise model. We also ask for 3000 burn-in iterations (this is to 
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achieve better convergence for the MCMC, but the default 1000 iterations would also work reasonably). 
Gradient nonlinearities can be accounted for using the -g flag (which instructs bedpostx to use the 
grad_dev.nii.gz file from the data folder and produce voxel-specific bvals and bvecs). For more 
information, see the BEDPOSTx section of the user guide at the FSL Wiki. For the HCP data it is really 
crucial to run bedpostx either on a large computing cluster or using GPUs , given the high resolution and 
large data files. 

• Type “ls” to list the contents of this directory.  

For every model parameter a distribution of values is estimated. The mean of this distribution is saved 
for every parameter (mean_*samples.nii.gz files). For the parameters used for tractography (e.g. 
orientations), samples from these distributions are also saved (merged_*samples.nii.gz files). For each 
fibre compartment an orientation and a volume fraction is estimated. The orientation is described in 
spherical coordinates by two angles, theta and phi. 

Thus, for example the files “mean_f2samples.nii.gz, mean_th2samples.nii.gz, mean_ph2samples.nii.gz” 
describe the mean values of the distributions estimated for the volume fraction and orientation of fibre 
2.  Files “merged_f2samples.nii.gz, merged_th2samples.nii.gz, merged_ph2samples.nii.gz” describe 
samples from these distributions. Note: in order for the wb_command below to run on the course 
machines and make an orientations file, we had to reduce the number of samples in these files from 50 
to 20, hence the file names:  reduced_merged_f1samples.nii.gz, etc. 

Visualising Orientations in Connectome Workbench 

All of these files can be opened as volume NIFTIs in Workbench. However, for better visualisation and 
more informative option, we convert them to an orientation Workbench file. On your terminal, run 
wb_command as follows: 

wb_command -estimate-fiber-binghams reduced_merged_f1samples.nii.gz \ 
reduced_merged_th1samples.nii.gz reduced_merged_ph1samples.nii.gz \ 
reduced_merged_f2samples.nii.gz reduced_merged_th2samples.nii.gz \ 
reduced_merged_ph2samples.nii.gz reduced_merged_f3samples.nii.gz \ 
reduced_merged_th3samples.nii.gz reduced_merged_ph3samples.nii.gz \ 
../Whole_Brain_Trajectory_1.25.nii.gz Whole_Brain_Orientations.fiberTEMP.nii 

This takes about 30 seconds to run and produces the file Whole_Brain_Orientations.fiberTEMP.nii that 
we can now open in Workbench. Note that files with the “reduced_” prefix are used, these files have 
been reduced to the first 20 (out of 50) samples due to the memory constraints of the course machines. 
For real use on more capable hardware, you would use the “merged_f1samples.nii.gz” and similar files. 
The output file summarises all orientation and volume fractions information for all fibre compartments 
in brain tissue regions. To open it along with a T1w image, enter: 

wb_view ../T1w_acpc_dc_restore_1.25.nii.gz \ 
Whole_Brain_Orientations.fiberTEMP.nii & 

Workbench will open with a volume tab displaying only the T1w Image. To view the fibres: 

http://fsl.fmrib.ox.ac.uk/fsl/fslwiki/FDT/UserGuide#BEDPOSTX
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• Open the Features Toolbox (from the menu View->Features Toolbox->Attach to Right) and tick 
Display Fibers.  

What you see in every voxel is the mean fibre orientation from every estimated distribution.  

• To make sure that you display fibers from a single slice, set the Slice Above/Below Limit entries to 
less than the voxel size (e.g. 0.5 and -0.5).  

• Zoom in until you can clearly see fibers associated with individual voxels. 

• Change the view to coronal/sagittal by selecting appropriately from the Slice Plane on the toolbar. 

There are many options for displaying orientations in the Features Toolbox that you can experiment 
with. By default, the option Draw with Magnitude is selected and displays each orientation with a 
magnitude proportional to the respective volume fraction.  

• Unselect Draw with Magnitude, then set Length Multiplier to 1, to display all fibre orientations with 
the same normalised length regardless of their volume fraction.  

The volume fractions carry important information, as the Automatic Relevance Determination priors 
imposed on them indirectly perform model selection (i.e. determine how many fibre orientations are 
supported by the data in every voxel - see lecture). By changing the Minimum Magnitude we can select 
fibre compartments that are supported by the data at various strengths. A minimum value of 0.05 is 
good enough for determining compartments with practical relevance.  

• Change the Minimum Magnitude value to 0.  

Now all three fibres estimated in every voxel are displayed, but the ones with too small volume fraction 
(<5%) look particularly noisy, implying that we have fitted more fibres than supported by the data.  

• Change the Minimum Magnitude value back to 0.05 to keep only the relevant fibre orientations. 
Note that only fibres with f>0.05 (by default) are considered for tractography. 

So far we have displayed the mean of the orientation distributions.  

• Change the Symbol from Lines to Fans to see a cone of uncertainty drawn for each fibre 
compartment, reflecting graphically the dispersion of the respective distribution. 

The Fan Multiplier entry controls the relative width of these cones for visualisation purposes. A value of 
1 corresponds to the width of the cone that reflects one standard deviation of the orientation 
distribution. 

Apart from the mean and uncertainty of the fibre orientation distributions, wb_view also enables display 
all the samples that have been estimated by bedpostX and fully describes the distribution in each voxel. 
DO NOT do the next two steps, they will crash the course machines. 

• Switch the Tab from Attributes to Samples. 
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• Select Show Orientations to display a spherical plot of all the orientation samples. 

The two figures below show what you would see IF you were/are using a computer having plenty of 
available RAM and were to click on voxels of interest in white matter.  The spherical plot can be rotated 
to observe the sample distribution relative to the three main axes (Superior-Inferior in Blue, Anterior-
Posterior in Green, Medial-Lateral in Red).  

The first example is from a voxel in the corpus callosum, where fiber bundles tend to be very tightly 
aligned.  Accordingly, this voxel shows only one major orientation and has very low uncertainty (all 
samples almost overlap, as indicated by the small red patch): 

 

A second example is from a voxel in the centrum semiovale, where there is a three-way fiber crossing 
(purple, blue, and green).  Note that the sample distribution is tightest for the purple fibre bundle.  For 
the other two fibre bundles, the sample distribution is not only broader, it is anisotropic (elliptical rather 
than circular), which provides evidence for fiber fanning (see below).   
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Another option is to superimpose cortical surface contours on the fibre orientation plots.   

• Select File->Open File -> Files of Type->Scene Files and open Tractography_Practical.scene (from 
/home/hcpcourse/day3-wednesday/Diffusion_practicals/100307/T1w/Diffusion.bedpostX) 

• Show the first scene (100307 pial and white surfaces…). 

This scene has loaded surface files (from the ../fsaverage_LR32k folder) in the subject’s T1w space.  

The Overlay Toolbox at the bottom shows the selection of pial and white surfaces for each hemisphere.  
In the Layers tab, you can toggle different surfaces on or off (including the midthickness surfaces, which 
are loaded but not displayed in this scene), and in the Vol/Surface Outlines tab you can change the 
colour and/or line thickness of each surface contour.  

Comparison with DTI orientations 

We will now load the DTI orientations that we computed in the previous practical and compare with the 
BedpostX orientations.  

• Go to File->Open File.... Go Up one directory and choose the Diffusion folder.  

• From the File types at the bottom, choose Connectivity - Fiber Orientations TEMPORARY Files 
(*.fiberTEMP.nii).  

• Choose the dtiV1.fiberTEMP.nii file and press Open.  
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The DTI orientations are now loaded and displayed along with the bedpostX orientations. 

• Go to the Features Toolbox on the right and toggle on Display FIbers.  

• Choose the Selection Tab and untick the dtiV1.fiberTEMP.nii so that the current window displays 
only bedpostx orientations.  

• Untick the Whole_Brain_Orientations.fiberTEMP.nii file and choose the dtiV1.fiberTEMP.nii so that 
the current window displays only DTI orientations.  

• Switch between the two to appreciate the rich crossing fibre information that is estimated using 
deconvolution. Notice that the DTI file contains deterministic orientation estimates with their length 
modulated by the FA, so only displays of Lines are meaningful. 

FSL ProbtrackX - Tractography 

Simple tracking - Connectivity from a single seed point 

• In wb_view, open the second scene (Mean_f1samples, crosshairs on (56,91,58) 

This shows a slice through the mean_f1samples volume (which has greater contrast between WM and 
GM than a T1w or T2w volume). The crosshairs (which can be turned on or off in the Preferences menu), 
are centered on a voxel in the internal capsule (the white matter tract shown in the picture; running 
between the caudate/thalamus and the putamen/pallidum). The specific co-ordinates (useful in a 
moment to run tractography using FSL) are (56,91,58), as indicated in the Toolbar (Slice 
Indices/Coords). 

• In the terminal, type: 

Fdt &  

This brings up FMRIB's diffusion toolbox (Fdt). It should default to "ProbTrackx" with "single voxel" as 
the selected seed mode. 

If you had enough memory on the course computers (DON’t do the following steps), you would: 

• Select Diffusion.bedpostx as the Bedpostx directory and enter your selected voxel coordinates 
(above) as the seed. Set the Output file to Tracts/SingleVoxel_paths. 

• Press Go (again, DON’T do this). Probabilistic tractography will start running. Alternatively, you can 
use the following commands in the terminal window.  

Notice that the command-line version of probtrackx is more flexible and has options that are not 
supported in the GUI.  Ifyou have enough memory (DON’T run this on the course computers), you could 
run the same in command line using: 

echo "56 91 58" >seedvox.txt  

Then (but DON’T run this on the course computers):  
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probtrackx2 --samples=merged --mask=nodif_brain_mask --seed=seedvox.txt --
simple --loopcheck --forcedir --opd -V 1 --dir=Tracts --out=SingleVoxel_paths  

• In wb_view, select File: Open File: Volume Files: Go up one level, select 
Diffusion.bedpostX/Tracts/SingleVoxel_paths_56_91_58.nii.gz to view the resultant connectivity 
distribution file on top of the mean_f1samples map - note the pathway's name ends with the 
coordinates of the seed voxel (basename_X_Y_Z.nii.gz).  

• Select SingleVoxel_paths_56_91_58 volume in the top layer of the Overlay Toolbox and toggle it 
on.  The connectivity-related voxels will appear black. 

• Show the third scene, Single-voxel tractography (56,91,58), to view a modified configuration of the 
same data. 

• Press the “wrench” icon for SingleVoxel_paths_56_91_58  

• In the Overlay and Map Settings window, note that the Palette is set to red-yellow and the 
Threshold is set to Type: On and Show Data Outside Thresholds.  

• If the connectivity pattern in the white matter appears black instead of yellow-red, toggle the 
Interpolate Colors button (under Palette) to make the pattern more colorful (This is currently a 
small glitch in how the scene palette is displayed). 

• Enter 10 for the High threshold, then press Return. 

Note that most of the fibre pathways have disappeared, because they are very sparse. 

• Enter 20 for the High threshold, press Return, and note that the dominant pathway runs dorsally up 
to cortex in the medial aspect of the hemisphere.   

Tracking in a standard / non-diffusion space 

It is common practice to use an atlas/standard space for defining coordinates and masks, because this 
improves alignment across subjects and provides standardisation. We have already obtained the 
transformation between the subject space to FSL’s MNINonlinear standard atlas space. We can now use 
this transform to perform tractography by defining a seed in that standard space. Notice that results will 
be also produced in the same space as the seed, so in this case standard space. 

• Close the Workbench window you have opened, as we will open a new instance. In the terminal: 

cd /home/hcpcourse/day3-wednesday/Diffusion_practicals/100307/MNINonLinear 

wb_view Tractography2_Practical.scene & 

• Open the first scene. 

This will display the T1w image for subject 100307 transformed to the standard space 
(T1w_restore_brain.nii.gz), with the crosshairs centered on the midbody of the corpus callosum 
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(129,157,137). 

• In the Fdt GUI, remain in "single voxel" seed mode, select "seed space is not diffusion" –  

This should bring up two new dialogues, specifying the Seed space.  

• Select "nonlinear" and a third dialogue will appear. 

• The "Seed reference image" is the image you selected the seed point from (T1w_restore_brain). 

• The seed to diff and diff to seed space registration transforms can be found in the 
MNINonLinear/xfms directory (the registration transforms have already been computed for you). In 
this case use standard2acpc_dc and acpc_dc2standard respectively. 

• Do NOT press “Go” because the course computers lack sufficient memory to successfully run 
probtrackx! 

Probtrackx can also be run by command line (but only IF you have enough computer memory).  To do 
this, you would use:  

echo "129 157 137" >seedvox.txt  

Then (but DON’T run this on the course computers): 

probtrackx2 --samples=../T1w/Diffusion.bedpostX/merged \ 
--mask=../T1w/Diffusion.bedpostX/nodif_brain_mask --seed=seedvox.txt \ 
--xfm=xfms/standard2acpc_dc --invxfm=xfms/acpc_dc2standard \ 
--seedref=T1w_restore_brain --simple --loopcheck --forcedir --opd -V 1 \ 
--dir=Tracts --out=SingleVoxel_paths   

• To view the precomputed results of this process, open the second scene in wb_view (SingleVoxel 
paths (129,157,137)…) to see a restricted set of fiber bundles running through this seed in the 
corpus callosum. 

• Press the “wrench” icon for SingleVoxel_paths_129_157_137, then - If the connectivity pattern in 
the white matter appears black instead of yellow-red - toggle the Interpolate Colors button (under 
Palette) to make the pattern more colorful. 

• Enter 10 for the High threshold and note that the ‘connected’ fiber bundles are highly restricted 
even with this low threshold. 

Using Anatomical priors in tractography 

Here we will make use of masks to inform/constrain tractography. There are various options in 
probtrackX to impose anatomical prior knowledge in the form of:  

a) Waypoint Masks (--waypoints option): Curves must go through these masks to be considered valid,  
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b) Exclusion Masks ( --avoid option): Curves that go through are invalid,  

c) Termination Masks (--stop option): Curves terminate when they cross,  

d) Walk-through Termination Masks (--wtstop option): Curves terminate when they cross the mask for a 
second time (useful for propagating within subcortical nuclei). 

We will see an example of reconstructing the Optic Radiation (pathway connecting the lateral geniculate 
nucleus (LGN) to the ipsilateral primary visual cortex (V1) that passes via Meyer's loop) with and without 
constraint masks. 

• If you have enough memory, you would run tractography using the LGN mask (file called 
MNINonLinear/ROIs/SEED_LGN_LEFT.nii.gz), which is in standard space, as follows:  

probtrackx2 --samples=../T1w/Diffusion.bedpostX/merged \ 
--mask=../T1w/Diffusion.bedpostX/nodif_brain_mask --seed=ROIs/SEED_LGN_LEFT \ 
--xfm=xfms/standard2acpc_dc --invxfm=xfms/acpc_dc2standard \ 
--seedref=T1w_restore.2 --loopcheck --forcedir --opd -V 1 --dir=Tracts \ 
--out=LGN_paths   

• To view the precomputed file, in wb_view, first open the third scene (“LGN seed”) to see the LGN 
seed used for this analysis.  

• Click on the wrench icon for this layer (SEED_LGN_LEFT.nii.gz (../ROIs)) and toggle Interpolate 
colors (if needed for coloring) 

• In the Overlay Toolbox, toggle the top layer on (“LGN_paths”) to see that without thresholding or 
other constraints, it contains a vast number of paths arising from the LGN.  

• Click on the wrench icon for this layer (LGN_PATHS.nii.gz (../Tracts)) and toggle Interpolate colors 
(if needed for coloring) 

• Adjust the high threshold to 200 by typing “200” into the box at the end of the slider by “High” in 
the palette settings window and press Enter, and note that the optic radiation is one of several 
major pathway that persist.  Then close the Overlay and Map Settings window. 

• Toggle off the top layer (“LGN_paths”) and toggle on the second layer (“TARGET_V1_LEFT.nii.gz 
(../ROIs)”) to see left area V1, which can be used as mask to isolate tracts that reach V1. This can be 
done using V1 as both a waypoint mask and as a termination mask to avoid tracts that reach V1 and 
then continue to other parts of the brain.  

• Click on the wrench icon for this layer (TARGET_V1_LEFT.nii.gz (../Tracts)) and toggle Interpolate 
colors (if needed for coloring). 

Finally if you had enough computer memory, you could use an exclusion mask that rejects paths that go 
to the frontal areas:  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probtrackx2 --samples=../T1w/Diffusion.bedpostX/merged \ 
--mask=../T1w/Diffusion.bedpostX/nodif_brain_mask --seed=ROIs/SEED_LGN_LEFT \ 
--xfm=xfms/standard2acpc_dc --invxfm=xfms/acpc_dc2standard \ 
--seedref=T1w_restore.2 --waypoints=ROIs/TARGET_V1_LEFT.nii.gz \ 
--stop=ROIs/TARGET_V1_LEFT.nii.gz --avoid=ROIs/EXCLUSION --loopcheck \ 
--forcedir --opd -V 1 --dir=Tracts --out=LGN_constrained_paths  

• To view the precomputed results, open the fourth scene (“Connections – LGN seeded, with 
masking”) and compare with the previous unconstrained version. The optic radiation forms the core 
of the distribution in the constrained scenario. 

• Click on the wrench icon for this layer, adjust the high threshold to 10, and note that the optic 
radiation is now more crisply delineated. 

Using Surfaces in Tractography 

So far we have used volumetric seeds/constraint masks. Probtrackx also supports using surface masks as 
seeds/constraints, which is important because long-distance pathways generally run exclusively through 
white matter and only branch locally in their cortical gray matter origins and terminations. For more 
details see the relevant FSL documentation. Here, we will see an example, where in order to avoid false 
positive connections that connect adjacent gyri, we impose the convoluted WM/GM boundary surface 
as a termination mask. Tracking will be performed again in standard space as before. We will first run an 
example without any surface constraints from a seed close to the cortex.  

IF you had sufficient computer memory, in the terminal window you would run: 

echo "151 196 183" >seedvox.txt   

probtrackx2 --samples=../T1w/Diffusion.bedpostX/merged \ 
--mask=../T1w/Diffusion.bedpostX/nodif_brain_mask -x seedvox.txt \ 
--xfm=xfms/standard2acpc_dc --invxfm=xfms/acpc_dc2standard \ 
--seedref=T1w_restore_brain --loopcheck --simple --forcedir --opd -V 1 \ 
--dir=Tracts --out=NoSurf_constraints 

• To view the precomputed results, open the 5th scene (“seed 151, 196, 183, no surface constraints”), 
which uses output Tracts/NoSurf_constraints.  

• Examine the coronal slice at position Y = 203, where it is evident that a spurious tract is connecting 
two adjacent gyri via an anatomically implausible path. This arises from the apposition of gyral gray 
matter  and the limits in MRI resolution. 

We will use the left and right WM/GM boundary surfaces as termination masks to prohibit this type of 
implausible "jumps" (similarly you can use the pial surfaces or midthickness surfaces). We will first 
convert the GIFTI surface provided with the HCP release to a more friendly ASCII format for probtrackx. 
We will use the tool surf2surf to perform the conversion and also remove from the HCP GIFTI surface 
the medial wall.  

http://fsl.fmrib.ox.ac.uk/fsl/fslwiki/FDT/UserGuide#Using_surfaces
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• In the terminal window run:  

surf2surf -i fsaverage_LR32k/100307.L.white.32k_fs_LR.surf.gii -o \ 
L.white.asc --outputtype=ASCII \ 
--values=fsaverage_LR32k/100307.L.atlasroi.32k_fs_LR.shape.gii surf2surf \ 
-i fsaverage_LR32k/100307.R.white.32k_fs_LR.surf.gii -o R.white.asc \ 
--outputtype=ASCII \ 
--values=fsaverage_LR32k/100307.R.atlasroi.32k_fs_LR.shape.gii  

Then, run tractography using these surfaces L.mid.asc and R.mid.asc as stopping masks:  

echo "L.white.asc" >stopsurfaces.txt  
echo "R.white.asc" >>stopsurfaces.txt   

IF you had sufficient computer memory, you could also run: 

probtrackx2 --samples=../T1w/Diffusion.bedpostX/merged \ 
--mask=../T1w/Diffusion.bedpostX/nodif_brain_mask -x seedvox.txt \ 
--xfm=xfms/standard2acpc_dc --invxfm=xfms/acpc_dc2standard \ 
--seedref=T1w_restore_brain --loopcheck --simple --forcedir --opd -V 1 \ 
--dir=Tracts --stop=stopsurfaces.txt --out=Surf_constraints 

• To view the precomputed tracking results, toggle on the top layer 
(“Surf_constraints_156_193_183…”) and toggle off the second layer (“NoSurf_constraints…”). 
Looking again at coronal slice 203 as before, the spurious connection should now be absent; the 
overall tracking results are now better delineated and more anatomically plausible. 

Connectivity-based segmentation 

Now that we have seen how to run some basic tractography, we will look into using tractography results 
to classify/segment an area by finding differences in the connectivity profiles of each voxel in that area. 
A connectivity-based seed classification analysis for the Thalamus has been run for you and is saved in a 
sub-directory called THAL2CTX_right within your MNINonLinear directory. This analysis was carried out 
in standard space, by seeding tractography from all voxels in the right thalamus and using cortical 
regions as target masks. 

We have volume masks that define seven different cortical regions(THAL2CTX_right/MASK_*.nii.gz. The 
objective of this type of analysis is to ask the following question: "For each location in the seed mask 
(thalamus), what is the probability of connection to each of my target masks". The output is therefore a 
single image for each target mask in which only voxels within the seed mask contain data. 

We could use directly the volume cortical masks, but to make the problem more interesting we will first 
convert the volume masks to cortical surface masks. We will then perform tractography-based 
parcellation of the thalamus using surfaces as targets. First we need to project the volume masks to a 
surface. 

For each of the seven masks, do the following (as an example for the primary motor cortex M1 region):  
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wb_command -volume-to-surface-mapping THAL2CTX_right/MASK_average_M1_right.nii.gz \ 
fsaverage_LR32k/100307.R.white.32k_fs_LR.surf.gii \ 
THAL2CTX_right/M1_atlasROI.roi.gii - \ enclosing  

then  

surf2surf -i fsaverage_LR32k/100307.R.white.32k_fs_LR.surf.gii -o \  
THAL2CTX_right/M1.white.asc --outputtype=ASCII \ 
--values=THAL2CTX_right/M1_atlasROI.roi.gii 

The seed mask will be ROIs/THALAMUS_RIGHT. The file THAL2CTX_right/targets.txt contains a list of the 
target surface masks used in this analysis.  

Then IF you had sufficient computer memory, you would run tractography as: 

probtrackx2 --samples=../T1w/Diffusion.bedpostX/merged \ 
--mask=../T1w/Diffusion.bedpostX/nodif_brain_mask \ 
--xfm=xfms/standard2acpc_dc --invxfm=xfms/acpc_dc2standard \ 
--seedref=T1w_restore.2 --seed=ROIs/THALAMUS_RIGHT.nii.gz --loopcheck \ 
--onewaycondition --forcedir --opd --dir=THAL2CTX_right \ 
--targetmasks=THAL2CTX_right/targets.txt -—os2t  

As mentioned before, the output is a single image for each target mask in which only voxels within the 
seed mask contain data. At each voxel within the seed mask the voxel value is the number of samples 
which reached this target mask from this seed voxel. These outputs can be found in 
THAL2CTX_right/seeds_to_* files. 

• In wb_view, open the sixth scene (“Thalamic connectivity with pmc mask (../THAL2CTX)”) to see 
thalamic connectivity with the premotor cortex (pmc) target mask (shown in yellow – after toggling 
Interpolate Colors, if necessary).  

• Toggle on the top two layers (“seeds_to_ppc….” and “MASK_averge_ppc…” to see the different 
pattern of thalamic connectivity with posterior parietal cortex. 

Other newly generated masks and thalamic seeds can be loaded from the THAL2CTX_right/ directory. 

Now we will use these files to classify the thalamus based on the connection probabilities to different 
target. Run find_the_biggest on the outputs of seeds to targets to generate a hard segmentation of the 
thalamus: 

find_the_biggest THAL2CTX_right/seeds_to_* \ 
THAL2CTX_right/biggest_segmentation   

• Open the seventh scene (“Thalamic connectivity – find the biggest”) to view this segmentation on 
the 100307 brain. The numbers in the image each correspond to a single target surface.The different 
numbers in the output image (biggest_segmentation) each relate to a different target mask, i.e. they 
tell you to which of the target regions each voxel in the thalamus is more likely connected. Note that 
the palette used for this display is JET256. 
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• Exit wb_view 
 

Connectome Matrix options in probtrackx: Matrix1, Matrix2, Matrix3 

Probtrackx supports the generation of various Connectome Matrices (see lecture). As shown in the 
figure below, there are choices for outputting different types of summary matrices (--omatrix1, --
omatrix2, --omatrix3 options. The seed and the target masks can be volumes, surfaces or a combination 
of the two, as is the case for HCP dense connectomes of GrayOrdinates x GrayOrdinates, where 
GrayOrdinates={Surface Vertex coordinates, Voxel coordinates}.  

We will focus on 
Matrix1 and Matrix3 
here, but you can learn 
more about Matrix2 
and how it can be used 
to perform 
connectivity-based 
parcellation from the 
relevant FSL 
documentation.  

If we are after a GrayOrdinates x GrayOrdinates square connectome matrix, then Matrix1 can be 
obtained by giving the set of GrayOrdinates as Seeds. This effectively means seeding from everywhere in 
the WM/GM boundary and the subcortical volumes and record propagation of curves to the same set of 
GrayOrdinates. For Matrix3, the Seed can be different from the target GrayOrdinates. Obviously these 
matrices can take very long to generate. We will see a simple example here of generating a Matrix1 
parcellated connectome using a small number of surface and volume ROIs. In the following section we 
will navigate through some precalculated dense connectomes. 

Let's assume we want to obtain the connectome matrix between N regions. As an illustration, we will 
choose two surface ROIs, the left M1 and the left occipital pole and one volume ROI, the left thalamus. 
All ROIs are in standard space. The thalamic ROI is in NIFTI format as ROIs/THALAMUS_LEFT.nii.gz and 
have been extracted from an atlas. Let's imagine we want to extract the surfaces that correspond to 
precentral and occipital regions.  

In the terminal: 

cd /home/hcpcourse/day3-wednesday/Diffusion_practicals 

cd 100307/MNINonLinear/fsaverage_LR32k  

wb_view 100307.32k_fs_LR.wb.spec & 

Once loaded, the displayed surfaces will have overlaid some label files that parcellate them into 
different ROIs.  

• Click on the Precentral gyrus (Blue Area) on one of the surfaces, the Information Box appears, 

http://fsl.fmrib.ox.ac.uk/fsl/fslwiki/FDT/UserGuide#Options_Tab


Exploring the Human Connectome   Practical 2: Fibre Orientation Models & Tractography 
Wednesday, June 10, 2015
  

Wednesday Practical 2: Fibre Orientation Models & Tractography  14 | P a g e  

informing you of the name of the chosen ROI for the different label files that are loaded. We will go 
with the Freesurfer-based parcellation 100307.aparc.32k_fs_LR, for which the name of the desired 
ROI is "precentral". Similarly, if we click at the occipital region (blue at the posterior part of the 
brain) we get the name "lateraloccipital". 

Extract the "precentral" and "lateraloccipital" surfaces from the label files, by running the following two 
commands:  

wb_command -gifti-label-to-roi 100307.L.aparc.32k_fs_LR.label.gii \ 
../ROIs/LPrecen.func.gii -name L_precentral 

wb_command -gifti-label-to-roi 100307.L.aparc.32k_fs_LR.label.gii \ 
../ROIs/LOccip.func.gii -name L_lateraloccipital 

We will also convert the obtained GIFTI surface files to ASCII as before:   

surf2surf -i fsaverage_LR32k/100307.L.white.32k_fs_LR.surf.gii -o \ 
ROIs/LPrecen.asc --values=ROIs/LPrecen.func.gii --outputtype=ASCII  \ 
surf2surf -i fsaverage_LR32k/100307.L.white.32k_fs_LR.surf.gii -o \ 
ROIs/LOccip.asc -- \ values=ROIs/LOccip.func.gii --outputtype=ASCII  

We can now run tractography using the surface ROIs and the thalamic volume ROI and obtain a Matrix1 
parcellated Connectome.  

IF you had sufficient computer memory, your probtrackx call would be:  

echo "ROIs/LPrecen.asc" > seeds.txt  

echo "ROIs/LOccip.asc" >>seeds.txt   

echo "ROIs/THALAMUS_LEFT.nii.gz" >>seeds.txt    

probtrackx2 --samples=../T1w/Diffusion.bedpostX/merged \ 
--mask=../T1w/Diffusion.bedpostX/nodif_brain_mask --seed=seeds.txt \ 
--xfm=xfms/standard2acpc_dc --invxfm=xfms/acpc_dc2standard \ 
--seedref=T1w_restore.2.nii.gz --loopcheck --forcedir --network --omatrix1 \ 
-P 1000 --avoid=ROIs/CSFmask.nii.gz -V 1 --dir=Network  

The output will now be in the Network directory. The file fdt_network_matrix is a 3x3 matrix containing 
the number of streamlines that start from ROI i and end up in ROI j: cat Network/fdt_network_matrix 
will display this matrix.  

The first row corresponds to the connections of the Precentral ROI to the other two, the second to the 
connections of the Occipital ROI and the third row to the connections of the thalamic ROI. Notice that 
these are unnormalised values, to normalise them each row can be divided by the respective rowsum 
(or entries in the Network/waytotal file). After such a division the matrix becomes:  0 0.0188 0.9812 
0.112 0 0.888 0.797 0.203 0  which suggests two strong projections between the thalamus and the 
surface ROIs. Notice the asymmetry in the Matrix, as tractography is not necessarily symmetric. I.e. it is 
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easier to track from the Cortex to the thalamus, than from the thalamus to the cortex. Why do you think 
that is the case? Finally, the ROIs are different in size and also surface ROIs will in general have less 
streamlines passing through them than volume ROIs (it is more difficult to hit a plane than a cube). 
These considerations need to be taken into account when interpreting this type of matrices.  

Dense Connectomes 

Dense Connectomes take a long time to compute and are very greedy on computational resources 
(using the standard 92,000 Grayrordinates of the HCP, gives us a final size of ~33 GB for the 92k x 92k 
connectome matrix). We have precomputed some dense connectomes using a computing cluster. 

The Grayordinates are defined in the file Connectomes/GrayOrdinates.txt and are all in standard space. 
The Left WM/GM boundary surface defines about ~30k vertices, followed by another ~30k vertices for 
the Right WM/GM boundary surface. The last ~32k grayordinates are voxel coordinates described in the 
NIFTI files Connectomes/CIFTI_STRUCTURE_*.nii.gz. To obtain a connectome using the Matrix1 option, 
we would seed tractography from each of these 92k Grayordinates and record the streamlines arriving 
to the rest. To obtain a connectome using the Matrix3 option, we would seed tractography from every 
voxel in the brain and for every obtained curve record which of the two grayordinates it intersects.  

In theory (don’t run), the probtrackx call for each of the two options would be (when called from the 
MNINonLinear directory: 

For Matrix1: 

probtrackx2 --samples=../T1w/Diffusion.bedpostX/merged \ 
--mask=../T1w/Diffusion.bedpostX/nodif_brain_mask \ 
--xfm=xfms/standard2acpc_dc \ 
--invxfm=xfms/acpc_dc2standard --seedref=T1w_restore.2.nii.gz \ 
--loopcheck --forcedir -c 0.2 --sampvox=2 --randfib=1 \ 
--stop=Connectome/stop --wtstop=Connectome/wtstop --forcefirststep \ 
--waypoints=ROIs/Whole_Brain_Trajectory_ROI_2 \ 
-x Connectomes/GrayOrdinates.txt --omatrix1 --dir=Connectomes 

For Matrix3: 

probtrackx2 --samples=../T1w/Diffusion.bedpostX/merged \ 
--mask=../T1w/Diffusion.bedpostX/nodif_brain_mask \ 
--xfm=xfms/standard2acpc_dc \ 
--invxfm=xfms/acpc_dc2standard --seedref=T1w_restore.2.nii.gz \ 
--loopcheck --forcedir -c 0.2 --sampvox=2 --randfib=1 \ 
--stop=Connectome/stop --wtstop=Connectome/wtstop \ 
--waypoints=ROIs/Whole_Brain_Trajectory_ROI_2 \ 
-x ROIs/Whole_Brain_Trajectory_ROI_2 --omatrix3 \ 
--target3=Connectomes/GrayOrdinates.txt --dir=Connectomes 

(Notice that only the last arguments change). In practice however, as this above commands would need 
impractically large amounts of memory and computing resources, we need to split and parallelise the 
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computation by using the --rseed option in probtrackx and using a small number of samples --nsamples 
per instance.  

That is, instead of running the above command, which will attempt to propagate 5000 curves per seed, 
we can run, e.g. , 100 instances of the above commands, using --nsamples=50 and --rseed=i, i=1..100. 
This will make sure that every instance runs with fewer curves per seed and a different random seed 
generator to produce a different stochastic result; thus, all these instances can be parallelised.  

The results at the end, obtained from all instances, can be merged using the FSL command 
fdt_matrix_merge. Notice that the final result of the above processes will be a matrix in standard sparse 
.dot format (which can be imported e.g. in MATLAB using the function spconvert()). To convert this 
result to a CIFTI dense connectome file, a final call of wb_command is needed with the option 
wb_command -probtrackx-dot-convert matrix1.dot Conn1.dconn.nii .... 

We have prepared some Workbench scene files to visualise the dense connectomes.  

• In your current directory (100307/MNINonLinear/fsaverage_LR32k), select File->Open File... and 
select from the MNINonLinear/Connectomes directory the Conn.scene file.  

After loading the scene file, you will see a montage view (tabs in 2 rows and 3 columns). Each row shows 
a different dense connectome and the columns show Left and Right hemispheres and subcortical 
volumes. The first row corresponds to a Matrix3 connectome, the second row corresponds to a Matrix3 
connectome with path distance correction (i.e. using the --pd option in probtrackx that instead of 
counting the number of streamlines, it weights the counts by the streamline length; thus longer 
connections are upweighted).  

• Click at different locations in one of the surfaces to update the connectome values for all panels.  

• Click around to get a feel of the differences between the different connectome types. For instance, 
click on the sensorimotor areas of the thalamus and see respective connections to the cortex. Or 
click on the frontal regions to see contralateral and subcortical connections. 

A parcellated version of these dense connectomes can be obtained using wb_command -cifti-parcellate 
and your favourite parcellation label file. Some parcellated connectomes have been obtained for you 
using standard Freesurfer parcellations in the Connectomes/Parcellated directory. Open them in 
Workbench and explore them (as well as exploring the "Chart View" option. 

End of Tractography Practical 
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